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1
Introduction 
This guide provides information about using the Dell OpenManage Plug-in Version 1.0 for Nagios XI and 
its various features such as discovering, monitoring, launching consoles, and troubleshooting of the 
supported Dell devices. The guide also provides details of the supported Dell devices and frequently 
asked questions by the customer.

This plug-in provides capabilities to monitor Dell devices in environments managed by Nagios XI. This 
plug-in gives you complete hardware-level visibility of Dell devices including overall and component-
level health monitoring. The plug-in provides basic inventory information and event monitoring of Dell 
devices. The plug-in also supports one-to-one web console launch of the supported Dell devices for 
further troubleshooting, configuration, and management activities.

For more details on the supported Dell device models, see Support matrix.
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2
Key features
The key features of the Dell OpenManage Plug-in Version 1.0 for Nagios XI are as described in the 
following table.

Table 1. Key features

Feature Functionality

Device discovery using Dell 
Configuration Wizard

Discovers the supported Dell devices in the Nagios XI console using 
the Dell configuration wizard. Once the discovery is complete, host 
and service definitions are created for each device.

To discover Dell servers through iDRAC with Lifecycle Controller, 
you can opt for either SNMP or WS-MAN protocol. Dell storage is 
discovered using SNMP protocol. Dell chassis is discovered using 
WS-MAN protocol.

For more information, see Dell configuration wizard.

Device information Displays information about the discovered device (Service Tag, 
Firmware Version, Device Name, Device Model, and so on) and its 
components (Physical Disks, Power Supply, Temperature Probe, 
Voltage Probe, and so on) after a device discovery is successful.

Monitor overall health of Dell 
devices

Monitors the overall health of Dell devices in a scheduled or 
periodic manner.

Component level health of Dell 
devices

Monitors the health of device components (Physical Disks, Power 
Supply, Temperature Probe, Voltage Probe, and so on) and displays 
information about the Dell device component status at scheduled 
time intervals.

Monitor alerts and events (Traps) Monitors alerts or events generated by Dell devices. This feature 
displays only the last received SNMP alert.

Launching device specific 
consoles

Launches the respective Dell one-to-one consoles to further 
troubleshoot and manage the supported Dell devices. For more 
information, see Launching Dell device consoles.

Warranty information Monitors and displays the warranty information for the supported 
Dell devices in a periodic manner and displays the status in the 
Nagios XI console. For more information, see Warranty information 
for Dell devices.

Knowledge Base (KB) Displays Knowledge Base (KB) information for the supported Dell 
devices corresponding to the device alert or event for faster 
troubleshooting.

For more information, see Knowledge Base (KB) information for the 
generated alerts.
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3
Support matrix
Dell OpenManage Plug-in for Nagios XI supports the Dell devices as listed in the following tables.

Supported firmware versions for Dell devices
Table 2. Supported firmware versions for Dell servers

Dell Servers iDRAC Firmware Versions 

Dell 12th generation of PowerEdge servers 2.30.30.30 and 2.21.21.21

Dell 13th generation of PowerEdge servers 2.30.30.30 and 2.21.21.21

Dell 13th generation of PowerEdge servers (R830) 2.35.35.35 and 2.30.30.30

Dell Datacenter Scalable Solutions (DSS 1500, 
DSS 1510 and DSS 2500)

2.30.30.30

Table 3. Supported firmware versions for Dell chassis

Dell Chassis CMC Firmware Versions 

Dell PowerEdge M1000e Chassis 5.12 and 5.11

Dell PowerEdge VRTX Chassis 2.12 and 2.10

Dell PowerEdge FX2/FX2s Chassis 1.32 and 1.30

Table 4. Supported firmware versions for Dell storage arrays

Dell Storage Arrays Firmware Versions 

Dell Compellent Storage Arrays 6.6 and 6.5

Dell EqualLogic PS-Series Storage Arrays 8.1.3 and 8.1.1

Dell PowerVault MD 34/38 Series Storage Arrays 08.25.04.60 and 08.20.12.60

Supported Dell PowerEdge servers
Table 5. Supported Dell PowerEdge servers

12th generation of PowerEdge servers 13th generation of PowerEdge servers

FM120x4 C4130

M420 C6320

M520 FC230
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12th generation of PowerEdge servers 13th generation of PowerEdge servers

M620 FC430

M820 FC630

R220 FC830

R320 M630

R420 M830

R520 R430

R620 R530

R720xd R530xd

R820 R630

R920 R730

T320 R730xd

T420 R830

T620 R930

R230

R330

T130

T330

T430

T630

Supported Dell Datacenter Scalable Solutions
Table 6. Supported Dell Datacenter Scalable Solutions

Dell Datacenter Scalable Solutions (DSS)

DSS 1500

DSS 1510

DSS 2500

Supported Dell chassis
Table 7. Supported Dell chassis

Dell chassis

Dell PowerEdge FX2

Dell PowerEdge FX2s
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Dell chassis

Dell PowerEdge VRTX

Dell PowerEdge M1000e

Supported Dell Compellent Storage Arrays
Table 8. Supported Dell Compellent Storage Arrays

Dell Compellent Storage Arrays

Compellent Series 40

Compellent SC4020

Compellent SC8000

Dell EqualLogic PS-Series Storage Arrays
Table 9. Supported Dell EqualLogic PS-Series Storage Arrays

Dell EqualLogic PS-Series Storage Arrays

EqualLogic PS4100

EqualLogic PSM4110

EqualLogic PS6100

EqualLogic PS6210

EqualLogic PS6500

EqualLogic PS6510

Dell PowerVault MD Storage Arrays 
Table 10. Supported Dell PowerVault MD Storage Arrays

Dell PowerVault MD Storage Arrays

PowerVault MD3400

PowerVault MD3420

PowerVault MD3460

PowerVault MD3800f

PowerVault MD3800i

PowerVault MD3820f

PowerVault MD3820i

PowerVault MD3860f

PowerVault MD3860i
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4
Dell configuration wizard
You can discover Dell devices using the Dell configuration wizard. This wizard takes you through a series 
of configuration steps where you provide appropriate input required to discover the hosts and associate 
them with their respective services. The Dell plug-in validates the inputs at the end of each step before 
proceeding to the next step and displays appropriate message prompts or summary.

Dell recommends that you discover a maximum of 255 devices at a time for a better user experience.

The devices are discovered either through SNMP or WS-MAN protocols. The monitoring protocols for the 
supported devices are as follows:

• Dell servers can be discovered using either SNMP or WS-MAN protocol. WS-MAN is the default 
protocol.

• Dell chassis can be discovered using WS-MAN protocol. WS-MAN is the default protocol.

Ensure that you only monitor Dell chassis using local user credentials.

• Dell storage can be discovered using SNMP protocol. SNMP is the default protocol.

You can discover devices using any of the following:

• Auto-Discovery Jobs – Select an auto discovery job.

• Subnet – Subnet with mask.

• File – A text file containing a list of newline separated, unique device Internet Protocol (IP) addresses.

 

Dell configuration wizard discovery parameters
You must configure the discovery parameters by providing inputs for device discovery. The parameters or 
inputs available in the Configuration Wizard are detailed in this section.

Discovery target

You can discover the devices by using options listed under Discovery target. The following table lists the 
options and their description:
Table 11. Discovery options

Option Description

Auto-Discovery Jobs Enables you to select a previously added auto discovery 
job.

To add Auto-Discovery Jobs to the Nagios XI console, 
see Creating Auto-Discovery Jobs.

Subnet Subnet with mask. You can enter a valid subnet address 
with mask.
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Option Description

File A text file containing a list of newline separated unique 
IP addresses.

To select a file, click the Browse button, navigate to the 
location where you have saved the file and select it.

Communication Parameters

The supported Dell devices can be discovered through either SNMP or WS-MAN protocol. Based on the 
desired protocol, you must configure the communication parameters. By default, WS-MAN protocol is 
selected.

Ensure that you select the Preferred protocol to discover Dell Agent-Free server appropriately. Selecting 
or not selecting this field does not have any impact while discovering Dell chassis or storage arrays. By 
default, chassis is discovered using WS-MAN protocol and storage arrays using SNMP.

Table 12. SNMP parameters

SNMP Parameters

Parameter Name Default Value Description

Community String public SNMP community string.

Version 2 SNMP version used for 
monitoring. Available options are 
1 and 2.

Timeout 3 Use to provide SNMP timeout 
value in seconds. Valid range is 1 
to 1440.

Retries 1 Use to provide the number of 
times an SNMP request must be 
sent when a timeout occurs. 
Valid range is 1 to 10.

Port 161 Use to provide the SNMP port 
value. Valid range is 1 to 65535.

Table 13. WS-MAN parameters

WS-MAN Parameters

Parameter Name Default Value Description

Username root Use to provide the WS-MAN user 
name.

Password NA. Masked Use to provide the WS-MAN 
password.

Timeout 3 Use to provide WS-MAN timeout 
value in seconds. Valid range is 1 
to 1440.
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WS-MAN Parameters

Retries 1 Use to provide the number of 
times a WS-MAN request must be 
sent when a timeout occurs. 
Valid range is 1 to 10.

Port 443 Use to provide the WS-MAN port 
value. Valid range is 1 to 65535.

Configuration Parameters

You can set the values for the configuration parameters based on your requirements.
Table 14. Configuration parameters

Configuration Parameters

Parameter Name Default Value Description

Warranty URL https://api.dell.com/support/
assetinfo/v4/getassetwarranty/

URL to fetch warranty details.

Warranty Critical Days 10 Number of days left before 
warranty expires.

Warranty Warning Days 30 Number of days left before 
warranty expires.

RACADM Install Path /opt/dell/srvadmin/sbin/racadm Absolute RACADM installation 
path.

JAVA Install Path /usr/bin/java Absolute Java installation path.

Creating auto-discovery jobs

You can create Auto-Discovery jobs in the Nagios XI console. These jobs will allow you to easily choose 
the hosts from an auto-discovery job that should be monitored.

To create auto discovery jobs, perform the following steps:

1. Select Configure → Configuration Wizards.

2. Add new auto discovery jobs by performing one of the following steps:

• Select Configuration Tools → Auto-Discovery in the left pane.

The Auto-Discovery Jobs page is displayed. Click the New Auto-Discovery Job button or the 
Add one now link.

• Click Auto-Discovery wizard from the list of wizards displayed.

Once the Configuration Wizard: Auto-Discovery - Step 1 page is displayed, click the launch a 
new discovery job link.

3. In the Scan Target field, enter a network address and netmask to define the IP ranges to scan.

4. In the Exclude IPs field, enter a comma-separated list of IP addresses and/or network addresses to 
exclude from the scan.

You can select a frequency from the Frequency drop down list if desired.

5. Click Submit.

The new Auto-Discovery job is created successfully and its details are displayed.
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Once an auto discovery job is added, you can select it by clicking Auto-Discovery Jobs under Discovery 
Target, in the Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 1 page, and then 
selecting the job you have just created from the drop down menu for device discovery. This will scan and 
discover only the new devices added to the job.

If you want to rediscover previously discovered devices or discover all the devices in the Scan Target 
range, check the Discover all IP addresses option.

Dell devices and associated services

Based on the Dell configuration wizard discovery parameters such as Discovery Target, Communication 
Parameters, and Configuration Parameters you have provided, a list of Dell Reachable Devices and the 
basic and detailed services associated with those devices are displayed in the Nagios XI console.

You can install the following optional service packages to monitor specific services:

• (Optional) Java version 1.6 or later is installed to view Dell warranty information.

• (Optional) Socket6 Perl module version 0.23 or later is installed for monitoring managed systems 
using Internet Protocol version 6 (IPv6).

• (Optional) SNMP Trap Translator (SNMPTT) is installed to receive SNMP alerts. Dell recommends that 
you use the latest version.

• (Optional) The supported Dell Remote RACADM utility is installed to monitor component attribute 
information of Dell chassis services such as:

– Speed(RPM) of the Dell Chassis Fan Status.

– InputCurrent(A) of the Dell Chassis PowerSupply Status.

– InputVoltage(V) of the Dell Chassis PowerSupply Status.

– OutputPower(W) of the Dell Chassis PowerSupply Status.

– Status of the Dell Chassis I/O Module Status.

Each of the services has the following parameters that you can configure based on your monitoring 
requirement:

• Check Interval - Used to define the number of "time units" to wait before scheduling the next 
"regular" check of the service.

• Retry Interval - Used to define the number of "time units" to wait before scheduling a re-check of the 
service.

• Max Check Attempts - Used to define the number of times that Nagios will retry the service check 
command if it returns any state other than an OK state.

The following tables list the basic and detailed services associated with the supported Dell devices.

Table 15. Services created for Dell servers based on the selected protocol

Services SNMP WS-MAN

Basic Services

Dell Server Overall Health Status √ √

Dell Server Information √ √

Dell Server Traps √ √

Detailed Services
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Services SNMP WS-MAN

Dell Server Physical Disk Status √ √

Dell Server Virtual Disk Status √ √

Dell Server Fan Status √ √

Dell Server Battery Status √ √

Dell Server Intrusion Status √ √

Dell Server Network Device Status √ √

Dell Server Voltage Probe Status √ √

Dell Server Controller Status √ √

Dell Server Amperage Probe Status √ √

Dell Server CPU Status √ X

Dell Server Power Supply Status √ X

Dell Server Temperature Probe Status √ √

Dell Server SD Card Status X √

Dell Server FC NIC Status X √

Dell Server Warranty Information √ √

Table 16. Services created for all Dell Chassis based on WS-MAN protocol

Services Description

Basic Services

Dell Chassis Overall Health Status This service is applicable to all supported Chassis.

Dell Chassis Information This service is applicable to all supported Chassis.

Dell Chassis Traps This service is applicable to all supported Chassis.

Detailed Services This service is applicable to all supported Chassis.

Dell Chassis Fan Status This service is applicable to all supported Chassis.

Dell Chassis Slot Information This service is applicable to all supported Chassis.

Dell Chassis I/O Module Status This service is applicable to all supported Chassis.

Dell Chassis Power Supply Status This service is applicable to all supported Chassis.

Dell Chassis KVM Status This service is applicable to all supported Chassis.

Dell Chassis Enclosure Status This service is applicable to Dell PowerEdge VRTX 
Chassis only.

Dell Chassis Controller Status This service is applicable to Dell PowerEdge VRTX 
Chassis only.

Dell Chassis Physical Disk Status
This service is applicable to Dell PowerEdge VRTX 
Chassis only.

Dell Chassis Virtual Disk Status
This service is applicable to Dell PowerEdge VRTX 
Chassis only.
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Services Description

Dell Chassis PCIe Devices Status This service is applicable to Dell PowerEdge VRTX 
Chassis and Dell PowerEdge FX2/FX2s Chassis 
only.

Dell Chassis Warranty Information This service is applicable to all supported Chassis.

Table 17. Services created for Dell Compellent Storage Arrays based on SNMP protocol

Services

Basic Services

Dell Storage Compellent Overall Health Status

Dell Storage Compellent Information

Dell Storage Compellent Management Traps

Dell Storage Compellent Controller Traps

Dell Storage Compellent Controller Overall Health Status

Dell Storage Compellent Controller Information

Detailed Services

Dell Storage Compellent Physical Disk Status

Dell Storage Compellent Volume Status

Dell Storage Compellent Controller Warranty Information

Table 18. Services created for Dell EqualLogic PS-Series Storage Arrays based on SNMP protocol

Services

Basic Services

Dell Storage EqualLogic Member Overall Health Status

Dell Storage EqualLogic Member Information

Dell Storage EqualLogic Group Information

Dell Storage EqualLogic Member Traps

Detailed Services

Dell Storage EqualLogic Member Physical Disk Status

Dell Storage EqualLogic Group Volume Status

Dell Storage EqualLogic Group Storage Pool Status

Dell Storage EqualLogic Member Warranty Information

Table 19. Services created for Dell PowerVault MD Storage Arrays based on SNMP protocol

Services

Basic Services

Dell Storage PowerVault MD Overall Health Status

Dell Storage PowerVault MD Information
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Services

Dell Storage PowerVault MD Traps

Detailed Services

Dell Storage PowerVault MD Warranty Information

Selecting the services to monitor for a Dell device

The supported Dell devices have basic and detailed services associated with them. You can choose to 
monitor all or any of these services at any given time.

By default, only the basic services are selected for a reachable or discovered Dell device based on the 
protocol you have selected. If you do not want to monitor any of the basic services, expand the Dell 
<device> Basic Services where <Device> is any of the reachable Dell devices that are listed under Dell 
Reachable devices and clear the check-box adjacent to it.

Similarly, to select any of the detailed services, expand Dell <device> Detailed Services, and then click the 
check-box adjacent to it.
For example:

To select the Dell Storage EqualLogic Group Storage Pool Information service, expand Dell Equal Logic 
Storage Array Detailed Services, and then click the check-box adjacent to it.
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5
Device discovery using the Dell 
configuration wizard
The following sections describe the process of discovering Dell devices and their associated services 
using the Dell monitoring wizard. Once you complete all the configuration steps successfully, the hosts 
and their corresponding services will be available for monitoring in the Nagios XI console.

Before you begin, ensure that all the prerequisites are installed in your system based on your monitoring 
requirements. For more information about the prerequisites, see the section System requirements for 
management systems in the Dell OpenManage Plug-in for Nagios XI Installation Guide.

 

Configuration Wizard: Dell OpenManage Plug-in for 
Nagios XI - Step 1
You can configure the various parameters for discovery of devices using the Dell OpenManage Plug-in 
such as target IPs, protocol parameters, warranty, and other configurations parameters.
Ensure that you provide only positive integer values when numeric values are required. For more 
information, see Dell configuration wizard discovery parameters.

If you encounter any errors while performing any of the following steps, ensure that you fix them before 
proceeding.

1. To open the Dell plug-in, under the Configure tab, select Configuration Wizards and then click Dell 
OpenManage Plug-in for Nagios XI.

The Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 1 page is displayed along 
with the overview of the plug-in and the summary of the prerequisite check.

2. Under the Discovery Target menu, select any of the following discovery options:

• Auto-Discovery Jobs - Select an existing Auto discovery job from the drop down menu.

• Subnet - Select to discover devices using a subnet with mask.

• File - Select to discover a list of devices using a file.

3. In the Communication Parameters table, provide appropriate values.

4. In the Configuration Parameters table, enter appropriate values based on your monitoring 
requirement, and then click Next.
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Figure 1. Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 1

Once the given values are accepted without errors, the Configuration Wizard: Dell OpenManage Plug-in 
for Nagios XI - Step 2 page is displayed.

Configuration Wizard: Dell OpenManage Plug-in for 
Nagios XI - Step 2
You can view the reachable Dell devices and their associated basic and detailed services based on the 
Discovery target, communication parameters, and configuration parameters you provided in 
Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 2.
Here, the summary of the Prerequisite Checks – Services for absolute installed path of SNMPTT, 
RACADM, and JAVA are displayed. Also displayed are the reachable or discovered devices under Dell 
Device Selection menu and their associated services under the Services Selection menu. For more 
information, see Dell devices and associated services.

To select discovered devices and the associated services that you would like to monitor, perform the 
following steps:

1. Under Dell Device Selection, click the  icon or the Dell Reachable devices link to expand the list of 
discovered devices.
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The reachable devices are displayed in a table along with their IP Address, Hostname, and Device 
Type.

By default, all the reachable devices are selected. You can remove devices you do not wish to 
monitor by simply clearing the check box against these devices.

2. Under Services Selection, click the required Dell device service to expand the list of associated 
services.

To view all the services, click Expand All.

The services associated with the discovered hosts are listed along with parameters such as Check 
Interval, Retry Interval, and Max Check Attempts with their default values. You can provide desired 
values based on your monitoring requirement.

3. Click Next once you have selected the devices and services you wish to monitor.

Once the given values are accepted without errors, the Configuration Wizard: Dell OpenManage Plug-in 
for Nagios XI - Step 3 page will be displayed.
If, at any point you want to change or correct any of the values you have provided in Configuration 
Wizard: Dell OpenManage Plug-in for Nagios XI - Step 1, in the previous page, you can do so by clicking 
the Back button.

Configuration Wizard: Dell OpenManage Plug-in for 
Nagios XI - Step 3
You can view the Dell devices and their associated services based on the selections you have made in 
Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 2. These devices and services are 
displayed as a collapsible list.
To view the discovery summary or details, perform the following steps:

1. Under Selected Devices, click the  icon or the Dell Devices link to expand the list of discovered 
devices.

The devices are displayed in a table along with their Host Address, Hostname, and Device Type.

2. Under Selected Services, click the required Dell device service to expand the list of selected services.

To view all the services, click Expand All.

The services associated with the discovered hosts that you have previously selected are listed along 
with parameters such as Check Interval, Retry Interval, and Max. Check Attempts with their values.

3. Click Next to further customize your monitoring requirements or click Finish to complete the 
configuration process and monitor the discovered devices.

For more information about how you can further customize your monitoring requirements, see the 
Nagios XI documentation at exchange.nagios.org.

If, at any point you want to change or correct any of the values you have provided in Configuration 
Wizard: Dell OpenManage Plug-in for Nagios XI - Step 2, you can do so by clicking the Back button.
The Dell device host and its service definitions are created in the Nagios server and this is subsequently 
used for monitoring the Dell devices. The discovered Dell devices and their services are displayed in the 
Host Detail view and the Service Detail view in the Nagios XI Home page respectively. However, you 
must wait for the scheduled service to complete for the service details to be displayed in the Nagios XI 
console.
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6
Viewing Dell devices
You can view the discovered Dell devices in the Nagios XI console in the Host Detail or the Service Detail 
view.

1. To view the hosts in the Nagios XI console, click the Home tab and then select Details → Host Detail 
in the left pane.

The discovered hosts are displayed in the right pane.

2. To view the services associated with the hosts in the Nagios XI console, click the Home tab and then 
select Details → Service Detail in the left pane.

The service details are displayed in the right pane.
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7
Monitoring Dell devices
Once you have discovered the Dell devices, you can monitor these devices and their associated services 
such as device information, overall health, and other components. The various aspects of Dell devices 
you can monitor are explained in the following sections.

 

Device information

The Dell device information service provides the basic information about the device. By default, this 
service is polled once a day.

Table 20. Device Information

Service Status Description Attributes Displayed

Dell Server Information The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information.

NOTE: Chassis Tag 
is applicable only 
for modular servers 
and Node ID is 
applicable only for 
PowerEdge 
FM120x4.

• Server Host FQDN

• Model Name

• Device Type (iDRAC7 
or iDRAC8)

• Service Tag

• Product Type 
(Monolithic or 
Modular)

• Chassis Tag

• iDRAC Firmware 
Version

• OS Name

• OS Version

• iDRAC URL

• Node Id

Dell Chassis 
Information

The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information for Dell 
PowerEdge M1000e, 
PowerEdge VRTX, and 
PowerEdge FX2/FX2s 
chassis.

• Chassis Name

• Model Name

• Service Tag

• CMC Firmware 
Version

• CMC URL

Dell Storage 
Compellent 
Information

The following states are 
possible:

• OK

• Unknown

This service provides the 
basic device inventory 
information for Dell 

• Storage Name

• Firmware Version

• Primary Controller 
Name
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Service Status Description Attributes Displayed

• Critical

• Warning

Compellent 
Management IP

• Primary Controller 
Model

• Primary Controller 
Service Tag

• Primary Controller IP

• Secondary Controller 
Name

• Secondary Controller 
Model

• Secondary Controller 
Service Tag

• Secondary Controller 
IP

• Compellent URL

Dell Storage 
Compellent Controller 
Information

The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information for Dell 
Compellent Controller 
IP

• Controller Name

• Model Name

• Service Tag

• Compellent URL

• Primary Controller

Dell Storage EqualLogic 
Group Information 

The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information for Dell 
EqualLogic Groups.

• Group Name

• Group URL

• Member Count

• Volume Count

Dell Storage EqualLogic 
Member Information 

The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information for the Dell 
EqualLogic Member.

• Member Name

• Product Family

• Model Name

• Service Tag

• Firmware Version

• Chassis Type

• Disk Count

• Capacity (GB)

• Free Space (GB)

• RAID Policy

• RAID Status

• Group Name

• Group IP

• Storage Pool
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Service Status Description Attributes Displayed

Dell Storage 
PowerVault MD 
Information

The following states are 
possible:

• OK

• Unknown

• Critical

• Warning

This service provides the 
basic device inventory 
information for Dell 
PowerVault MD Storage 
Arrays.

• Storage Name

• Product ID

• Service Tag

• World-wide ID

For information about the various components that you can monitor, see Monitoring component health.

Overall health status 

Overall health status of a device is polled periodically based on the configured interval. By default, the 
Overall Health Status service is scheduled once an hour.

Table 21. Overall health Status information

Service Status Description Attributes 
Displayed when 
using WS-MAN

Attributes 
Displayed when 
using SNMP

Dell Server Overall 
Health Status

The following 
states are possible 
for the supported 
Dell devices:

• OK

• Warning

• Unknown

• Critical

Provides global 
health status of 
Dell servers.

• Overall System

• Battery

• Memory

• Voltage

• Storage

• Power Supply

• Fan

• Temperature

• Overall System

• Internal Dual SD 
Module 
(IDSDM) Card 
Unit

• Battery

• Power Supply

• Secure Digital 
(SD) Card 
Device

• SD Card Unit

• Cooling Unit

• Fan

• Chassis

• IDSDM Card 
Device

• Amperage

• Power Unit

• Voltage

• Processor

• Temperature

• Chassis 
Intrusion
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Service Status Description Attributes 
Displayed when 
using WS-MAN

Attributes 
Displayed when 
using SNMP

• Storage

Dell Chassis 
Overall Health 
Status

Provides global 
health status of 
Dell chassis.

Overall Chassis NA

Dell Storage 
EqualLogic 
Member Overall 
Health Status 

Provides global 
health status of 
Dell EqualLogic 
Storage Arrays.

NA Overall Member

Dell Storage 
Compellent 
Overall Health 
Status

Provides global 
health status of 
Dell Compellent 
Storage Arrays.

NA Overall Storage 
Center

Dell Storage 
Compellent 
Controller Overall 
Health Status

Provides global 
health status of 
Dell Compellent 
Storage Array’s 
controller.

NA Overall Controller

Dell Storage 
PowerVault MD 
Overall Health 
Status

Provides global 
health status of 
Dell PowerVault 
MD Storage Arrays.

NA Overall Storage 
Array

The status of the storage attribute indicates the cumulative health status of storage components such as 
physical disk, virtual disk, and controller.

Component health

This is a periodic poll based health monitoring of a Dell device’s component level health status. By 
default, the component health service is scheduled once every four hours.

Once the discovery utility is run with the relevant option, the corresponding services are created. These 
services run periodically and update the overall health of the components. The component’s status and 
information are displayed in the Nagios XI console.

The format of the component information in the Status Information column is <Attribute>=<Value>, 
<Attribute>=<Value>.

For example: Status=CRITICAL, FQDD=Fan.Embedded.1, State=Enabled
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Table 22. Dell device component health information

Service Status Description Attributes 
Displayed when 
using WS-MAN

Attributes 
Displayed when 
using SNMP

Dell Server 
Physical Disk 
Status

The following 
states are possible:

• OK

• Warning

• Unknown

• Critical

Provides the worst 
case aggregate 
health status of the 
physical disks in 
Dell servers.

• Status

• FullyQualifiedD
eviceDescriptor 
(FQDD)

• State

• ProductID

• SerialNo

• Size(GB)

• FirmwareVersio
n

• MediaType

• FreeSpace(GB)

• Status

• FQDD

• State

• FirmwareVersio
n

• FreeSpace(GB)

• MediaType

• ProductID

• SerialNo

• Size(GB)

Dell Server Virtual 
Disk Status

Provides the worst 
case aggregate 
health status of the 
virtual disks in Dell 
servers.

• Status

• FQDD

• State

• Size(GB)

• WritePolicy

• ReadPolicy

• Layout

• StripeSize

• MediaType

• Status

• FQDD

• State

• Layout

• MediaType

• ReadPolicy

• Size(GB)

• StripeSize

• WritePolicy

Dell Server Fan 
Status

Provides overall 
health status of the 
fans in Dell servers.

• Status

• FQDD

• State

• Speed(RPM)

• Status

• FQDD

• State

• Speed(RPM)

Dell Server Battery 
Status

Provides overall 
health status of the 
battery in Dell 
servers.

• Status

• Location

• State

• Reading

• Status

• Location

• State

• Reading

Dell Server 
Intrusion Status

Provides overall 
health status of the 
chassis intrusion in 
Dell servers.

• Status

• Location

• State

• Reading

• Status

• Location

• State

• Type

• Reading

Dell Server 
Network Device 
Status

Provides the worst 
case aggregate 

• ConnectionStat
us

• FQDD

• ConnectionStat
us

• FQDD
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Service Status Description Attributes 
Displayed when 
using WS-MAN

Attributes 
Displayed when 
using SNMP

health status of the 
NIC in Dell servers.

• Name

• FirmwareVersio
n

• LinkSpeed

• Name

Dell Server CPU 
Status

Provides overall 
health status of the 
CPUs in Dell 
servers.

Not Available • Status

• FQDD

• State

• CoreCount

• CurrentSpeed(
GHz)

• Name

Dell Server Power 
Supply Status

Provides overall 
health status of the 
power supply in 
Dell servers.

Not Available • Status

• FQDD

• CapabilitiesStat
e

• InputWattage(
W)

• OutputWattag
e(W)

• SensorState

Dell Server 
Temperature 
Probe Status

Provides overall 
health status of the 
temperature probe 
in Dell servers.

• Status

• Location

• State

• Reading(degree 
Celsius)

• Status

• Location

• State

• Reading(degree 
Celsius)

Dell Server 
Voltage Probe 
Status

Provides overall 
health status of the 
voltage probe in 
Dell servers.

• Status

• Location

• State

• Reading

• Status

• Location

• State

• Reading

Dell Server 
Controller Status

Provides the worst 
case aggregate 
health status of the 
storage controllers 
in Dell servers.

• Status

• FQDD

• CacheSize(MB)

• FirmwareVersio
n

• Name

• Status

• FQDD

• CacheSize(MB)

• FirmwareVersio
n

• Name

Dell Server 
Amperage Probe 
Status

Provides overall 
health status of the 

• Status

• Location

• State

• Status

• Location

• State
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Service Status Description Attributes 
Displayed when 
using WS-MAN

Attributes 
Displayed when 
using SNMP

amperage probe in 
Dell servers.

• Reading(A) or 
Reading(W)

• Reading(A) or 
Reading(W)

Dell Server SD 
Card Status

Provides overall 
health status of the 
SD card in Dell 
servers.

• Status

• FQDD

• State

• WriteProtected

• InitializedState

• Size(GB)

• AvailableSpace(
GB)

Not Available

Dell Server FC NIC 
Status

Provides overall 
health status of the 
FC NIC in Dell 
servers.

• ConnectionStat
us

• FQDD

• Name

• FirmwareVersio
n

• LinkSpeed

Not Available

Dell Server 
Warranty 
Information

Provides warranty 
information status 
for the Dell servers.

• ServiceTag

• Service Level 
Details

• Item number

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days 
Remaining

• ServiceTag

• Service Level 
Details

• Item number

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days 
Remaining

Table 23. Dell chassis component health information

Service Status Description Attributes Displayed 
when using WS-MAN

Dell Chassis Physical 
Disk Status

The following states are 
possible:

• OK

• Warning

• Unknown

• Critical

Provides the worst case 
aggregate health status 
of the physical disks in 
Dell chassis.

Applicable only to Dell 
PowerEdge VRTX 
chassis.

• Status

• FQDD

• Capacity(GB)

• FirmwareVersion

• FreeSpace(GB)

• MediaType

• Model

• PartNumber

• SecurityState
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Service Status Description Attributes Displayed 
when using WS-MAN

• Slot

Dell Chassis Virtual Disk 
Status

Provides the worst case 
aggregate health status 
of the virtual disks in 
Dell chassis.

Applicable only to Dell 
PowerEdge VRTX 
chassis.

• Status

• FQDD

• BusProtocol

• Capacity(GB)

• Media Type

• Name

• RAIDTypes

• ReadPolicy

• StripeSize

• WritePolicy

Dell Chassis PCIe 
Devices Status

Provides the worst case 
aggregate health status 
of all the Dell chassis 
PCIe device instances

• FQDD

• Name

• AssignedBlade

• AssignedSlot

• Fabric

• PowerState

• PCIeSlot

Dell Chassis Fan Status Provides the worst case 
aggregate health status 
of the fans in Dell 
chassis.

• Status

• FQDD

• Name

• Slot

• Speed(RPM)

Dell Chassis Power 
Supply Status

Provides the worst case 
aggregate health status 
of the power supply in 
Dell chassis.

• Status

• FQDD

• InputCurrent(A)

• InputVoltage(V)

• Name

• OutputPower(W )

• PartNumber

• Slot

Dell Chassis Controller 
Status

Provides the worst case 
aggregate health status 
of the storage 
controllers in Dell 
chassis.

Applicable only to Dell 
PowerEdge VRTX 
chassis.

• Status

• FQDD

• CacheSize(MB)

• FirmwareVersion

• Name

• PatrolReadState

• SecurityStatus
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Service Status Description Attributes Displayed 
when using WS-MAN

• SlotType

Dell Chassis Enclosure 
Status

Provides the worst case 
aggregate health status 
of the enclosure in Dell 
chassis.

Applicable only to Dell 
PowerEdge VRTX 
chassis.

• Status

• FQDD

• BayID

• Connector

• FirmwareVersion

• SlotCount

Dell Chassis IO Module 
Status

Provides the worst case 
aggregate health status 
of the IO module in Dell 
chassis.

• Status

• FQDD

• FabricType

• IPv4Address

• LaunchURL

• Name

• PartNumber

• Slot

Dell Chassis Slot 
Information

Provides the worst case 
aggregate health status 
of the slot in Dell 
chassis.

• Status

• SlotNumber

• HostName

• Model

• ServiceTag

• iDRACIP

Dell Chassis KVM Status Provides the worst case 
aggregate health status 
of the KVM (Keyboard, 
Video, Mouse) in Dell 
chassis.

• Status

• Name

Dell Chassis Warranty 
Information

Provides warranty 
information status for 
the Dell chassis.

• ServiceTag

• Service Level Details

• Item number

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days Remaining
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Table 24. Dell EqualLogic component health information

Service Status Description Attributes Displayed 
when using WS-MAN

Dell Storage EqualLogic 
Member Physical Disk 
Status

The following states are 
possible:

• OK

• Warning

• Unknown

• Critical

Provides the worst case 
aggregate health status 
of the physical disks in 
the Dell EqualLogic 
member.

• Status

• Slot

• FirmwareVersion

• Model

• SerialNumber

• TotalSize(GB)

Dell Storage EqualLogic 
Group Volume Status

Provides the worst case 
aggregate health status 
of the volume in 
EqualLogic Group.

• Status

• Name

• TotalSize(GB)

• AssociatedPool

Dell Storage EqualLogic 
Group Storage Pool 
Information

Provides the worst case 
aggregate health status 
of all the Dell 
EqualLogic storage 
arrays in a storage pool.

• Name

• MemberCount

• VolumeCount

Dell Storage EqualLogic 
Member Warranty 
Information

Provides warranty 
information status for 
the Dell EqualLogic 
member.

• ServiceTag

• Service Level Details

• Item number

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days Remaining

Table 25. Dell Compellent component health information

Service Status Description Attributes Displayed 
when using WS-MAN

Dell Storage 
Compellent Physical 
Disk Status

The following states are 
possible:

• OK

• Warning

• Unknown

• Critical

Provides the worst case 
aggregate health status 
of the physical disks in 
Dell Compellent storage 
arrays.

• Status

• Name

• BusType

• DiskEnclosureNumb
er

• TotalSize(GB)

Dell Storage 
Compellent Volume 
Status

Provides the worst case 
aggregate health status 
of the Dell Compellent 
volume.

• Status

• VolumeName

Dell Storage 
Compellent Controller 
Warranty Information 

Provides warranty 
information status for 

• ServiceTag
• Service Level Details
• Item number
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Service Status Description Attributes Displayed 
when using WS-MAN

the Dell Compellent 
controller.

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days Remaining

Table 26. Dell PowerVault MD warranty information

Service Status Description Attributes Displayed 
when using WS-MAN

Dell Storage 
PowerVault MD 
Warranty Information

The following states are 
possible:

• OK

• Warning

• Unknown

• Critical

Provides warranty 
information status for 
the Dell PowerVault MD 
storage arrays.

• ServiceTag

• Service Level Details

• Item number

• Device Type

• Ship Date(UTC)

• Start Date(UTC)

• End Date(UTC)

• Days Remaining

NOTE: 

For more information about monitoring the health of the Compellent controllers, see the specific 
Dell Compellent Controllers User’s Guide at Dell.com/support.

The Dell Chassis enclosure status displays the Primary Status of the Enclosure only. For more 
information, see Dell PowerEdge VRTX Chassis console or the Dell PowerEdge VRTX Chassis User’s 
Guide at Dell.com/support.

Monitoring alerts and events (Traps)
You can asynchronously receive the alerts and events (traps) generated by the discovered Dell devices. 
Once an alert is received, the respective device’s service displays the alert summary message and alert 
severity of the last received alert in the Nagios XI console.

The following table lists the traps supported by the various Dell devices:

Table 27. Dell trap information

Service Status Description

Dell Server Traps The following states are possible:

• OK

• Warning

• Unknown

Provides trap information of the 
Dell servers discovered through 
the agent-free method.
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Service Status Description

• Critical

Dell Chassis Traps The following states are possible:

• OK

• Warning

• Unknown

• Critical

Provides trap information of the 
Dell M1000e, VRTX, and FX2/
FX2s chassis.

Dell Storage EqualLogic Member 
Traps

The following states are possible:

• OK

• Warning

• Unknown

• Critical

Provides trap information of the 
Dell EqualLogic PS-Series storage 
Arrays.

Dell Storage Compellent 
Controller Traps

The following states are possible:

• OK

• Warning

• Unknown

• Critical

Provides trap information of the 
Dell Compellent storage Arrays.

Dell Storage PowerVault MD 
Traps

The following states are possible:

• OK

• Warning

• Unknown

• Critical

Provides trap information of the 
Dell PowerVault MD storage 
Arrays.

Viewing SNMP alerts

Prerequisites:

• SNMPTT is installed and configured and the Dell integration on SNMPTT is configured.

• SNMP Trap destination is configured in the supported Dell devices.

To view SNMP alerts:

1. In the Nagios XI user interface, click the Home tab, then select Service Detail in the left pane.

The Service Status page is displayed.

2. Navigate to the respective Dell device specific trap service.

Only the last received SNMP alert is displayed in the status information and the severity of the alert is 
updated in the status.
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Launching Dell device consoles
You can launch the Dell device specific console to further troubleshoot any issue that you may 
encounter while monitoring that device. You can do so from either the Host Detail or the Service Detail 
view in the Nagios XI console.

1. Navigate to the Nagios XI Home page.

2. Click Host Detail or Service Detail in the left pane.

3. In the right pane, under Host, click a host for which you wish to launch the console.

The Host Status Detail page is displayed for the selected host.

4. Select Advanced option by clicking the  icon.

The Advanced Status Details page is displayed.

5. Under More Options, click the View in Nagios Core link.

The Host Information page is displayed.

6. Click  (Extra Actions icon) adjacent to the Dell device.

The respective Dell console is launched in a new window.

 

Dell devices and their consoles
You can launch various Dell consoles from the supported Dell devices to get more information about the 
Dell devices you are monitoring.

Table 28. Dell devices and their consoles

Dell Device Applicable Console

Dell Servers Dell Integrated Remote Access Controller Console

Dell PowerEdge M1000e Chassis Dell PowerEdge M1000e Chassis Controller Management 
Console

Dell PowerEdge VRTX Chassis Dell PowerEdge VRTX Chassis Controller Management 
Console

Dell PowerEdge FX2/FX2s Chassis Dell PowerEdge FX2 Chassis Controller Management 
Console

Dell Compellent Storage Arrays Dell Compellent Storage Manager Console

Dell EqualLogic PS-Series Storage Arrays Dell EqualLogic Group Manager Console
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Warranty information for Dell devices
With this feature, you can access the warranty information for the discovered Dell devices. This feature 
allows you to monitor the Dell device’s warranty details in the Nagios XI console. An active Internet 
connection is required to retrieve the warranty information. If you do not have direct internet access and 
are using proxy settings to access the internet, ensure that you resolve the host name api.dell.com in 
the etc/hosts file.

Warranty information attributes

The warranty information for the respective Dell devices is displayed in the Nagios XI console. The Dell 
devices are polled for their warranty information at regular intervals. The default schedule for warranty 
polls on the discovered devices is once every 24 hours.

Once a discovered device is polled for its warranty information, the following warranty attributes are 
displayed in the Nagios XI console:

• ServiceTag – Service tag for the discovered device.

• Service Level Details – Description of the type of warranty.

• Item number – Dell item number for this type of warranty.

• Device Type – Type of warranty.

• Ship Date(UTC) – Date the asset was shipped.

• Start Date(UTC) – Date when the warranty begins.

• End Date(UTC) – Date when the warranty ends.

• Days Remaining – Number of days left for the warranty to expire.

The warranty information status is determined based on the warranty parameter definitions and has the 
following severities:

• Normal - Indicates that warranty is due to expire in more than <Warning> days. The default value is 30 
days.

• Warning - Indicates that warranty is due to expire from <Warning> days before <Critical> days.

The default values for <Warranty> and <Critical> are 30 days and 10 days respectively.

• Critical - Indicates that warranty is due to expire within <Critical> days. The default value is 10 days.

• Unknown - Indicates that warranty information cannot be retrieved.

WarrantyURL - The warranty URL address.

If the warranty for a Dell device has expired or the Days Remaining is equal to zero, then the severity 

for that device is Critical.
 

Viewing warranty information
Before you can view the warranty information for the discovered Dell devices, ensure the following:
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• You have an active internet connection.

• The discovered device has a valid service tag.

Once a device has been successfully discovered, its warranty information is displayed under the Status 
Information column. To view the details for a Dell device,

1. Discover a Dell device.

2. Click the <Dell device> Warranty Information under services.

The details for the selected device are displayed in the Service State Information page.

For example:

To view the warranty service information for Dell VRTX Chassis, click Dell Chassis Warranty Information.

NOTE: In case of Dell EqualLogic storage arrays, the warranty service will be associated only with 
the EqualLogic Member IP.

In case of Dell Compellent storage arrays, the warranty service will be associated only with the 
Compellent Controller IP.

In case of Dell PowerVault MD Storage Arrays, the warranty information is available only for the 
latest firmware version.
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Knowledge Base (KB) information for the 
generated alerts
You can get more information about the SNMP alerts generated by the discovered Dell devices from the 
KB messages for that device in the Nagios XI console.
The following section provides steps to view KB information.
 

Viewing KB information
You can get more information about the SNMP alerts generated by the discovered Dell devices from the 
KB messages for that device in the Nagios XI console.
To view the KB messages for an SNMP alert generated by a discovered Dell device, perform the following 
steps:

1. Log in to Nagios XI.

2. In the left pane, click Service Detail under Details.

3. Navigate to the respective device trap or alert under Service, right-click More Information hyperlink 
under Status Information and then select Open in new tab. The KB messages for the respective 
device is displayed in a new tab.

4. In the KB messages page, search for the respective event ID or the KB message as displayed in the 
Nagios XI console to view further details about this alert.

For Example: To view the KB messages for Chassis traps:

1. Scroll down to Dell Chassis Traps under Service, right-click More Information hyperlink under 
Status Information and then select Open in new tab.

2. Search for the respective event ID or KB message as generated by the Dell Chassis Traps such as 
LIC212 to view further details about this Dell chassis alert.

If you are not able to find the KB messages for any of the generated alerts by this process, go to 
“Dell.com/support/article/us/en/19” and search for the KB messages using the event ID or KB message as 
generated by the Dell device.
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Removing Dell devices or services
You can remove a Dell device that you do not want to monitor. Before removing a host, you must first 
delete all the services associated with that host.

1. Log in to Nagios XI with your credentials.

2. Navigate to Configure, and then click Core Congfig manager from the dropdown menu.

3. In the right pane, under the Nagios XI Summary tab, click Services.

Alternatively, you can click Services under Monitoring in the left pane.

All the services associated with the discovered hosts are displayed.

4. Select the services you want to remove by clicking the check box adjacent to that host and then 
select Delete from the With Checked: dropdown menu at the bottom of the right pane.

To delete only a single service, click the  icon under Actions menu.

Alternatively, you can enter the host IP address in the search box and click Search. This will filter all 
the services associated only with that host. Select the services you want to remove and then delete 
them.

5. Click OK to confirm.

The selected services are deleted.

6. Click Apply Configuration at the bottom of the page.

The selected services are deleted.

 

Removing Dell devices
Once you have removed all the services associated with a host that you want to remove from your data 
center, perform the following steps:

1. Log in to Nagios XI with your credentials.

2. Navigate to Configure, and click Core Congfig manager.

3. In the right pane, under the Nagios XI Summary tab, click Hosts.

Alternatively, you can click Hosts under Monitoring in the left pane.

The discovered hosts are displayed.

4. Select the hosts you want to remove by clicking the check box adjacent to that host and then select 
Delete from the With Checked: dropdown menu at the bottom of the right pane.

To delete only a single host, click the  icon under Actions menu.

Alternatively, you can enter the host IP address in the search box and click Search. Select the host 
and then delete it.

5. Click OK to confirm.
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6. Click Apply Configuration at the bottom of the page.

The selected hosts are deleted.
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Troubleshooting 
This section lists the problems that you may encounter while using the Dell OpenManage Plug-in for 
Nagios XI and their workarounds.

All the services (service parameters) for the devices 
discovered using SNMP are not getting displayed in the 
Nagios XI console
1. Ensure that you have installed Net-SNMP version 6.0.1 or later.

2. Rediscover the devices.

Status Information gets truncated at 256 characters in 
the Service Detail view

In the Nagios XI interface, the Status Information shown for a service stops at 256 characters (anything 
after is truncated).

For more information to resolve this problem, see support.nagios.com/kb/article.php?id=478 or 
Common Problems Articles in support.nagios.com/kb.

Unable to connect to iDRAC

If you cannot connect to iDRAC, this could be due to iDRAC7 or iDRAC8 being enabled by default with 
Transport Layer Security (TLS) versions 1.1 or higher as the cryptographic protocol for secure 
connections. For more information about resolving this problem, see bugzilla.redhat.com/show_bug.cgi?
id=1170339.

IPv6 SNMP traps are not getting associated with the 
corresponding Dell Devices

This is not due to a limitation of the Dell OpenManage Plug-in but due to a bug in how the Net-SNMP 
libraries spool the received IPv6 traps. Due to this, SNMPTT is not able to resolve the IPv6 address to the 
correct DNS record and this consequently results in an incorrect IPv6 address submitted to Nagios XI.

For more information about the Net-SNMP bug, see sourceforge.net/p/net-snmp/bugs/2704/.

For more information about how to configure Nagios XI to receive IPv6 traps, see Nagios Knowledge 
Base (KB) article at support.nagios.com/kb/article.php?id=499.
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The Nagios XI Console is not displaying the trap service 
for the discovered Dell devices

1. Install SNMPTT.

If SNMPTT is not installed, then the trap service is not created for any of the discovered Dell device.

2. Perform Trap Integration by navigating to cd <NagiosXI installed path>/html/includes/configwizards/
Dell_OM_NagiosXI_monitoring_wizard/script, and then run the command: 

./postinstall.sh trap

3. Provide the path where the snmptt.ini file is installed, and then press ENTER. Alternatively, you 

can press Enter to continue with the default file path, /etc/snmp/snmptt.ini.

4. Provide the path where trap configuration files are installed, and then press ENTER to continue. 
Alternatively, you can press Enter to continue with the default file path, '/usr/local/nagios/libexec'.

5. Once the trap integration is complete, restart the SNMPTT service, run the following command:

service snmptt restart
6. Rediscover the device using the monitoring wizard and select the respective trap service in 

Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 2.

The Dell OpenManage Plug-in specific services display 
the message, “Error while creating SNMP Session”

Ensure that the following conditions are met:

1. The recommended versions of Net-SNMP and Net-IP are installed. If you are using IPv6, then the 
Perl module Socket6 should also be installed.

2. The IP addresses or hosts provided are reachable.

3. SNMP is enabled on the IP addresses or hosts.

Dell OpenManage Plug-in specific services display the 
message, “WSMAN Error while communicating with host”

Ensure that the following conditions are met:

1. OpenWSMAN and its Perl binding and Net-IP are installed.

2. The IP addresses or hosts provided are reachable.

Dell OpenManage Plug-in specific services display the 
message, “Component Information = UNKNOWN”

NOTE: This is an expected message if the component is not available in the discovered Dell device.

If the component is available and you are still receiving the message, then it could be due to a protocol 
timeout. Rediscover the device using the monitoring wizard, and set the protocol specific timeout values 
based on your monitoring requirements.
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Unable to view the SNMP alerts generated by the Dell 
device in the Nagios XI Console

Verify that you have correctly installed SNMPTT and then perform the following steps to integrate traps:

1. Navigate to cd <NagiosXI installed path>/html/includes/configwizards/
Dell_OM_NagiosXI_monitoring_wizard/script and run the command: 

./postinstall.sh trap

2. Provide the path where the snmptt.ini file is installed, and then press ENTER. Alternatively, you 

can press Enter to continue with the default file path, /etc/snmp/snmptt.ini.

3. Provide the path where trap configuration files are installed, and then press ENTER to continue. 
Alternatively, you can press Enter to continue with the default file path, '/usr/local/nagios/libexec'.

4. Once the trap integration is complete, restart the SNMPTT service, run the command:

service snmptt restart

Unable to monitor certain chassis specific component 
attribute information in the Nagios XI Console

The following component attribute information of Dell chassis are dependant on the RACADM utility:

• Speed(RPM) of the Dell Chassis Fan Status.

• InputCurrent(A) of the Dell Chassis PowerSupply Status.

• InputVoltage(V) of the Dell Chassis PowerSupply Status.

• OutputPower(W) of the Dell Chassis PowerSupply Status.

• Status of the Dell Chassis I/O Module Status.

Install RACADM and wait till the next polling cycle to complete.

Alternatively, you can select the service and then click the Force an immediate check link under Quick 
Actions in the Service Status Detail page.

For more information about downloading and installing RACADM, go to “en.community.dell.com/
techcenter/systems-management/w/wiki/3205.racadm-command-line-interface-for-drac”

Unable to monitor the Warranty information for the 
discovered Dell devices in the Nagios XI Console
• Ensure that you have an active internet connection. If you do not have direct internet access and are 

using proxy settings to access the internet, ensure that you resolve the host name api.dell.com in 
the etc/hosts file.

If you are still not able to view the warranty information, then ensure that you have Java version 1.6 or 
later installed in your system. If Java was installed after the Dell Plug-in was installed, then perform the 
following steps:

1. Install JAVA.
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2. Rediscover the device using the monitoring wizard and select the Warranty information service in 
Configuration Wizard: Dell OpenManage Plug-in for Nagios XI - Step 2.
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Frequently asked questions
1. Question: Can you provide information about licensing of Dell OpenManage Plug-in for Nagios XI? 

Answer: You can install and use this plug-in for free.

2. Question: What are the Dell hardware models supported by the plug-in? 

Answer: For the list of supported Dell platforms, see Support matrix.

3. Question: I have an earlier generation of servers (9th Generation – 11th Generation) in my data 
center. Can I still monitor them using the plug-in? 

Answer: No, you cannot monitor earlier generations of servers (9th Generation through 11th 
Generation) using this plug-in. You can only monitor Dell servers through iDRAC with LC, supported 
for 12th and later generations of Dell PowerEdge servers using this plug-in. There are other plug-ins 
available on Nagios Exchange using which you can monitor earlier generation of servers.

4. Question: What is the difference between in-band versus out-of-band (OOB) method of monitoring 
Dell servers? 

Answer: There are two ways to monitor Dell servers, one is by using in-band method through 
software called OpenManage Server Administrator (OMSA) installed on a server operating system 
and the other is out-of-band method through iDRAC with LC.

iDRAC with LC, a hardware, is on the server motherboard and iDRAC with LC enables system 
administrators to monitor and manage Dell servers regardless of whether the machine is powered 
on, or if an operating system is installed or functional. The technology works from any location and 
without the use of software agents like OMSA. By contrast, in-band management, that is, OMSA 
must be installed on the server being managed and only works after the machine is booted and the 
operating system is running and functional. The OMSA software has its limitations such as it does not 
allow access to BIOS settings or the reinstallation of the operating system and cannot be used to fix 
problems that prevent the system from booting.

5. Question: Can I monitor Dell servers using OpenManage Server Administrator (OMSA) agent instead 
of iDRAC with LC using this plug-in? 

Answer: No, by using this plug-in, you cannot monitor Dell servers using OMSA agent. However, 
there are other plug-ins available on Nagios Exchange using which you can achieve the same. For 
more information, regarding the list of available Dell Plug-ins, visit URL: exchange.nagios.org/
directory/Plugins/Hardware/Server-Hardware/Dell.

6. Question: How is this plug-in different from other plug-ins available on the Nagios Exchange site? 

Answer: The primary functionality of this plug-in is to monitor the supported Dell devices’ hardware 
through an agent-free, out-of-band method using iDRAC with LC (Dell PowerEdge servers), Dell 
Chassis, and Dell Storage Arrays. With this plug-in, you can get a comprehensive hardware-level 
information about the discovered Dell devices (including overall and component-level health 
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monitoring) through SNMP and WS-MAN protocols as supported by the devices. The plug-in 
enables you to monitor alerts or events (traps) generated from Dell devices and supports web 
console launch for the same to perform further troubleshooting, configuration, and management 
activities. Some of the capabilities provided here are not available in other plug-ins present on 
Nagios Exchange.

7. Question: What are the languages supported by the plug-in?

Answer: The plug-in currently supports only English language.

8. Question: Where do I find the OpenWSMAN distribution and its Perl binding?

Answer: If the system has default Perl version (installed as part of operating system), go to 
“Build.opensuse.org/package/show/Openwsman/openwsman” and download the OpenWSMAN 
library and its Perl binding.

If you have installed a Perl version other than the default version or the Perl binding is not available, 
then go to “Github.com/Openwsman/openwsman” and follow the instructions to compile and use 
the Perl bindings.
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Appendix

Configuring SNMP parameters for iDRAC using the iDRAC 
web console 
1. Launch the iDRAC (12th and later generation of Dell PowerEdge servers) web console, and navigate 

to Network → Services in the console. 

2. Configure the following SNMP Agent properties:

a. Set Enabled to True and SNMP Protocol to All (SNMP v1/v2/v3).

b. Set SNMP Community Name to a community string.

c. Click Apply to submit the configuration.

NOTE: The Plug-in communicates with iDRAC using only SNMP v1 or SNMP v2 protocol.

Configuring SNMP parameters for iDRAC using RACADM 
script 
1. Launch the iDRAC RACADM CLI by running the following ssh command:

ssh root@<iDRAC IP>
2. Change the command mode to racadm by running the following command:

racadm
3. Set the SNMP community string by running the following command:

 racadm set idrac.SNMP.AgentCommunity <community string>
4. Enable the SNMP agent by running the following command:

racadm set idrac.SNMP.AgentEnable 1
(Values: 0 – Disabled, 1 – Enabled) 

5. Set the SNMP protocol to All by running the following command:

racadm set idrac.SNMP.SNMPProtocol 0 
(Values: 0 – All, 1 – SNMPv3)

6. Verify the configuration by running the following command:

racadm get idrac.SNMP.Alert

Configuring SNMP trap destination address for iDRAC 
using iDRAC web console
1. Log in to iDRAC.

2. Select Overview → Alerts.

3. In the right pane, perform the following actions:
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• In the Alerts section, enable Alerts.

• In the Alerts Filter section, select the required fields under Category and Severity.

You will not receive any SNMP alerts if none of these fields are selected.

• In the Alerts and Remote System Log Configuration section, select the required fields thereby 
configuring the SNMP alerts.

4. In the right pane, click the SNMP and Email Settings tab and then perform the following actions:

• In the IP Destination List section, populate the Destination Address fields as per your 
requirement and ensure that its respective State checkboxes are selected and then click Apply.

• Configure the Community String and the SNMP Alert Port Number at the bottom of the IP 
Destination List section as required and then click Apply.

• In the SNMP Trap Format section, select the required SNMP trap format and then click Apply.

Configuring SNMP trap destination address for iDRAC 
using RACADM 
1. Launch the iDRAC RACADM CLI by running the following ssh command:

ssh root@<iDRAC IP>
2. Change the command mode to racadm by running the following command:

racadm
3. Set the iDRAC SNMP port for receiving alerts by running the following command:

 racadm set idrac.SNMP.AlertPort <Trap Port Number> 
4. Enable the SNMP monitoring protocol by running the following command:

racadm set idrac.SNMP.TrapFormat <Trap Format>
(Values for <Trap Format>: 0– SNMPv1, 1–SNMPv2, 2–SNMPv3) 

5. Set the SNMP trap destination by running the following command:

racadm set iDRAC.SNMP.Alert.DestAddr.<index> <Trap Destination IP Address>
(This will override the trap destination address, if any, existing in that index)

6. Enable the index by running the following command:

racadm set iDRAC.SNMP.Alert.Enable.<index> 1
(Only eight trap destinations can be configured in iDRAC. You can only pass a trap destination 
<index> value from 1 to 8.)

7. Run the following command to enable global email alerting:

racadm set iDRAC.IPMILan.AlertEnable 1
8. Run the following command to clear all available alert settings:

racadm eventfilters set -c idrac.alert.all -a none -n SNMP

You can also use the Perl based command line script to configure the SNMP parameters for multiple 
iDRACs (Dell 12th and later generation of PowerEdge Servers). For more information, go to 
en.community.dell.com/techcenter/systems-management/w/wiki/11460.snmp-parameters-
configuration-script-for-dell-idracs.

For more information about RACADM commands, see the iDRAC RACADM Command Line Interface 
Reference Guide available at dell.com/iDRACManuals.
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Related documentation and resources
This chapter gives you the details of other documents and resources to help you work with the Dell 
OpenManage Plug-in for Nagios XI.

 

Other documents you may need
In addition to this guide, you can access the following guides available on the Dell Support website at 
Dell.com/support/manuals. On the Manuals page, click Software & Security and click the appropriate 
product link to access the documents:

• Integrated Dell Remote Access Controller 8 with Lifecycle Controller User’s Guide

• Dell Integrated Remote Access Controller 7 User’s Guide

• Dell Chassis Management Controller for Dell PowerEdge M1000e User’s Guide

• Dell Chassis Management Controller for Dell PowerEdge VRTX User’s Guide

• Dell Chassis Management Controller for Dell PowerEdge FX2/FX2s User’s Guide

• Dell Compellent Storage Arrays User’s Guide

• Dell EqualLogic PS-Series Storage Arrays User’s Guide

• Dell PowerVault MD Storage Arrays User’s Guide

Also see www.nagios.org/documentation for any Nagios XI related documentation.

Accessing documents from Dell support site

You can access the required documents in one of the following ways:

• Using the following links:

– For all Enterprise Systems Management documents — Dell.com/SoftwareSecurityManuals

– For OpenManage documents — Dell.com/OpenManageManuals

– For Remote Enterprise Systems Management documents — Dell.com/esmmanuals

– For iDRAC and Lifecycle Controller documents — Dell.com/idracmanuals

– For OpenManage Connections Enterprise Systems Management documents — Dell.com/
OMConnectionsEnterpriseSystemsManagement

– For Serviceability Tools documents — Dell.com/ServiceabilityTools

– For OpenManage Connections Client Systems Management documents — Dell.com/
DellClientCommandSuiteManuals

• From the Dell Support site:

a. Go to Dell.com/Support/Home.

b. Under Select a product section, click Software & Security. 
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c. In the Software & Security group box, click the required link from the following:

– Enterprise Systems Management

– Remote Enterprise Systems Management

– Serviceability Tools

– Dell Client Command Suite

– Connections Client Systems Management 

d. To view a document, click the required product version.

• Using search engines:

– Type the name and version of the document in the search box.

Contacting Dell
NOTE: If you do not have an active Internet connection, you can find contact information on your 
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by 
country and product, and some services may not be available in your area. To contact Dell for sales, 
technical support, or customer service issues:

1. Go to Dell.com/support.

2. Select your support category.

3. Verify your country or region in the Choose a Country/Region drop-down list at the bottom of the 
page.

4. Select the appropriate service or support link based on your need.
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